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1 Introduction
1.1 Preface
The setup program is used for the easy creation of configuration files, and to
configure the instruments from a PC.

Please read these instructions before commissioning the software. Keep the
instructions in a place which is accessible to all users at all times.

Please assist us in improving these instructions where necessary.

Your comments will be appreciated.

H
However, if any difficulties should arise during start-up, please do
not carry out any unauthorized manipulations. You could endanger
your rights under the instrument warranty!

Please contact the nearest subsidiary or the head office in such a
case.

B
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1 Introduction
1.2 Arrangement of the documentation
The documentation for this instrument is addressed to equipment
manufacturers (OEMs) and users with appropriate technical expertise. It
consists of the following parts:

Instrument documentation in printed form

B 706585.1 Operating Instructions

The operating instructions are an extract from the operating manual and cover
the basic operation of the paperless recorder.

B 706585.4(.1) Installation Instructions

The installation instructions describe the installation of the recorder and the
connection of the supply and signal cables. The instructions also contain a list
of the technical data.

B 706585.4 Installation instructions for recorders with die-cast zinc front

B 706585.4.1 Installation instructions for recorders with stainless steel front

Instrument documentation in the form of PDF files

The “Instrument documentation in the form of PDF files” is on the CD that is
included in the delivery.

B 706585.0 Operating Manual

It contains information about commissioning, operation, parameterization and
configuration on the instrument.

B 706585.1 Operating Instructions

The operating instructions are an extract from the operating manual and cover
the basic operation of the paperless recorder.

B 706585.2.0 Interface Description (serial interfaces)

This provides information on the communication (RS232/RS485) with
supervisory systems.

Interface Description (Ethernet interface)

This provides information on the connection of a paperless recorder to a
company-internal network. This description is integrated into B 706585.2.0.

B 706585.2.3 Interface Description (PROFIBUS-DP interface)

This provides information on the connection of a paperless recorder to a
PROFIBUS-DP system.
8



1 Introduction
B 706585.4(.1) Installation Instructions

The installation instructions describe the installation of the recorder and the
connection of the supply and signal cables. The instructions also contain a list
of the technical data.

B 706585.4 Installation instructions for recorders with die-cast zinc front

B 706585.4.1 Installation instructions for recorders with stainless steel front

B 706585.6 Setup Program

The manual describes the function of the setup program. The setup program is
available as an option.

T 706585 Data Sheet

The data sheet contains general information, the order details and the
technical data.

B 709701.0 PC Evaluation Software (PCA3000)

The operating manual describes the operation and the features of the PC
Evaluation Software.

PCA3000 serves to visualize and evaluate process data (measurement data,
batch data, messages, instrument audit trails, ...). The process data can be
read in via the CompactFlash memory card, or made available through the
PCC software.

B 709702.0 PCA Communication Software (PCC)

The operating manual describes the operation and the features of the PCA
Communication Software.

PCC is responsible for the data transfer from the recorder to a PC, or to a
network.

B 709703.0 PC Security Manager Software (PCS)

The operating manual describes the operation and the features of the PC
Security Manager Software.

The PCS ensures that only authorized persons can gain access to the system
components (instrument, PC software) and use electronic signatures on
electronic documents.

The configuration of the Security Manager can only be performed by the
system administrator.
9



1 Introduction
B 709704.0 PC Audit Trail Manager Software (PCAT)

The operating manual describes the operation and the features of the PC
Audit Trail Manager Software.

PCAT documents actions performed in the PC software components, which
lead to modifications of files, user lists (rights files), device lists etc. The
different message types are: “Information”, “Warnings” and “Errors”.

Audit trail records cannot be modified.

Internet

H
Device audit trail data are not shown in PCAT, only in PCA3000.

H All documents are available for downloading at www.jumo.net
10



1 Introduction
1.3 Typographical Conventions

Warning signs

The signs for Danger and Caution are used in this manual under the following
conditions:

A

Warning

This symbol is used when there may be damage to equipment or data if the
instructions are ignored or not followed correctly!

Note signs

H

Note

This symbol is used when your special attention is drawn to a remark.

v

Reference

This symbol refers to further information in other manuals, chapters or
sections.

abc1
Footnote

Footnotes are remarks that refer to specific points in the text. Footnotes
consist of two parts:

A marker in the text, and the footnote text.

The markers in the text are arranged as continuous superscript numbers.

h

Action instruction

This symbol indicates that an action to be performed is described.

The individual steps are marked by this asterisk, e.g.

h Press the h key

h Confirm with E
11



1 Introduction
Presentation modes

h + E

Keys

Keys are shown in a box. Both symbols and text are possible. If a key has a
multiple function, then the text shown is the one that corresponds to the
function that is active at the moment.

Edit 
Device data

Menu items

Menu items in the software which are referred to in this operating manual are
shown in italics. Menu name, menu item and submenu item are separated
from each other by “”.

1.4 Hardware and software requirements
The following hardware and software requirements must be met to install and
operate the setup program:

Minimum
configuration

• Intel Pentium1 4 or higher

• Microsoft Windows2 2000, Windows XP, Windows Vista, Windows 7 (32-bit 
and 64-bit version) 

• 512 Mbyte main memory

• CD drive

• mouse

• one free serial interface or network connection, or CompactFlash memory 
cards or USB flash drive (depending on the type of data transmission to the 
paperless recorder), and

• 700 Mbyte available on hard disk

1 Intel and Pentium are registered trademarks of Intel Corporation
2 Microsoft and Windows are registered trademarks 

of Microsoft Corporation
12



2 Installation
The setup software is used for the easy creation of configuration files, and to
configure the devices from a PC. It is on a CD, together with the PC software
components:

- PC Evaluation Software (PCA3000)
(visualization, evaluation and archiving of process data on the PC),

- PCA Communications Software (PCC)
(transfer of the data from the device to the PC),

- PC Security Manager Software (PCS)
(creation and administration of user lists or PC and device rights files) and 

- PC Audit Trail Software (PCAT)
(documentation of operator actions).

2.1 Starting the Installation

Running the 
installation
program

h Start Microsoft Windows

h Insert the CD into the drive, then close the drive.

After the CD has been inserted, the installation program will start
automatically. If not, proceed as follows: 

h Start file “Launch.exe” in the main directory of the CD.

Screen messages from the installation program will now lead you through the
rest of the installation.

H
If Microsoft Windows has already been started, all Windows 
programs must be shut down before installing the setup program.
13



2 Installation
License
agreement

h Read and confirm the license agreement. Accepting the agreement is the 
basic precondition to be able to install the software.

Available 
software

h Select the components that need to be installed.

Software that is to be installed must be 
marked by a tick ( ).
14



2 Installation
License number h Now enter the required license numbers. You can find the numbers on the 
cover of the CD.  

Program folder h Define the program folder into which the icons for starting the software will 
be copied. The directory for the program files is defined automatically.

Carry out 
installation

h The final action is to click  to initiate the actual installation.

Preparations 
for starting the 
program

Before starting the program for the first time, a user list (PC rights file) has to
be created using the PC Security Manager Software (PCS) and made
accessible to the PC on which the setup software is to run.

v Additional information about the PC Security Manager Software (PCS) can
be found in the operating manual B 709703.0.

Program start The selected software components will now be installed. When installation has
been completed, start the setup program from the Windows start menu.

H
If the "30-day test version" option is set during installation, the 
setup program will be fully functional for 30 days. After 30 days, 
certain features of the program, forexample data transfer, data 
storage, and printing, will automatically be disabled.

The software can be licensed at a later stage.

H Please note that not all functions are available to all users. Which
functions of the setup program are available, can be decided
through the PC Security Manager Software (PCS). 
15



2 Installation
2.2 Quick Start Agent

Installation When the installation setup program is installed, another program called the
"Quick Start Agent" is installed. This program starts automatically and appears
in the Windows task bar. 

Automatic
program start

This program monitors the exchangeable media of a computer and responds,
forexample, if a paperless recorder or USB memory stick is connected to the
computer. It provides a list of all PC programs connected to the device that
was found. The user can decide which PC program to start. If only program is
available, it starts immediately. 

Settings The user can change the program options with the button. The program
options are:

• Language of the program, 

• Selection of programs that can be started, and 

• the option of preventing Autostart.

Icon for the Quick Start 
 Agent program

Start selected program
Select program

Change program options
16



2 Installation
Exit 
program 

To exit the program, the user can left- or right-click the program icon ( ) in the
Windows task bar.

Manual
program start

To exit the program in the foreground, the user can left- or right-click the

program icon ( ) in the Windows task bar.

If Autostart is inactive, i.e. the program icon is not included in the task bar, it
can be started manually through the Windows start menu. The Quick Start
Agent can be found in the same program group in which the setup program
was installed.

Program in 
foreground

The picture shows the Quick Start Agent as it appears in the foreground.

Exit program 

Show program
17



2 Installation
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3 Log-in and Rights
3.1 Logging in to the Program
When the software has just been installed for the first time, there will not yet be
a prompt for the user name and password. In the Tools menu, the prompt at
the start of the program can be activated by the function Renew log-in/Alter
password.
The activation of the log-in function can be used to distinguish between the
user types “Specialist” and “Maintenance”. These two users have different
access rights with regard to the functions in the setup program.

v Chapter 8.11 "Renew Log-in/Alter Password"

If the prompt is active, proceed as follows:

h Log in.

H
Please note that not all functions are available to all users.

v Chapter 3.2 "Rights with Regard to the Setup Program"
19



3 Log-in and Rights
3.2 Rights with Regard to the Setup Program
Depending on the installation and the log-in, individual users will have different
rights within the setup program.

The differences are summarized in the table below:

Right Demo
installation

Main-
tenance

Specialist

Write interface texts - x x

New x x x

Open x x x

Save, Save as, 
Delete

- x x

Configure undocumented 
parameters

- - x

Export to CF card or 
USB stick 

- x x

Import from CF card or 
USB stick 

- x x

Print - x x

Enable 
program options

x - x

Enable extra codes - - x

Edit interface 
settings

- x x

Edit device settings x x x

Delete device - - x

Create new device x - x

x = right is available - = right is not available
20



4 User Interface
4.1 Elements of the User Interface

Menu bar The individual functions of the setup program can be started by using the
menu bar.

v Chapter 5 "File Menu"

Toolbar The toolbar contains selected functions from the menu bar. They can be
started from the left mouse button. If you rest the mouse pointer on one of the
icons (tool tips), you will see the function title after a short while. 

Menu bar

Toolbar 

Working area

Connection status Teleservice
21



4 User Interface
Moving the  
toolbar

The position of the toolbar can be changed if desired. 

h Move the mouse pointer between two icon groups.

h Click (press the left mouse button). 

h Keeping the left mouse button pressed and drag the symbol bar to the 
required position.

h Now release the mouse button.

Possible positions are:

• the left or right window border (vertical orientation),

• below the menu bar (horizontal orientation),

• at the bottom edge, above the user details (horizontal orientation) or

• any position (in own window -  horizontal orientation).

Working area Here you are provided with an overview of the current settings of a
configuration file. 

v Chapter 4.2 "Configuration"

Connection 
status

In the “Connection status” line you can check whether a connection to a
device has been established, and which interface data are being used. The
line can be shown or hidden with Window ➔ Connection status.

Example: No connection

Example: Connection to a device

The line can be moved (like the toolbar). In order for the shift to work, first
position the mouse pointer on the  icon, then press the left mouse  button.

Teleservice You can use Teleservice to look at the latest data from a paperless recorder.
Teleservice can be shown or hidden with function Window ➔ Teleservice.

v Chapter 9.4 "Teleservice"
22



4 User Interface
4.2 Configuration
You can use function File ➔ New (or File ➔ Open) to create a new
configuration file (setup) or open an already existing one. The working area will
be filled in with the corresponding settings. 

Navigation tree Clicking once in the navigation tree will position the entry so it is visible in the
dialog window. 

Click  to reduce the size of the display; click  to enlarge the display again.

You can double-click an entry (e.g. ) to start the change dialog.
As an alternative, a change can be started via the menu bar (Edit ➔  Device
data).

Dialog window To launch the change dialog, double-click an entry in the dialog window. Click
“Arrow to right” ( ) before the entry to list the current setting in the dialog
window; click “Arrow down” ( ) to hide the current setting again.

Current setup If several setup settings are open at the same time, simply clicking the name is
sufficient to ...

Navigation tree, for finding 
the settings quickly

Dialog window  
The settings appear here.

Current setup
23



4 User Interface
... make that window become the active window.

Functions 
of the right 
mouse button

If you use the right mouse button in the dialog window, different functions will
be available. These functions are related to the submenu on which the mouse
pointer was positioned when you right clicked.

Example: 
You right clicked when the mouse was positioned on the entry “Analog
inputs”.

Analog inputs  Edit

This function starts the change dialog for configuring the analog inputs.
Configuring can also be started by double-clicking (with the left mouse
button).

Analog inputs  Maximize

This function displays the current configuration of the analog inputs. As an
alternative, the current configuration can also be displayed by clicking (left
mouse button) “Arrow to right” ( ).

Copy data to clipboard  Analog inputs

This function copies the current configuration of the analog inputs to the
Windows clipboard. The contents of the clipboard can be imported into an
editor or a text processing program, etc.
24



4 User Interface
Copy data to clipboard  All data

This function copies the complete current configuration – not just that for the
analog inputs – to the Windows clipboard. The contents of the clipboard can
be imported into an editor or a text processing program, etc.

Print

This function enables the printout of the latest setting. You can select which
parameter groups are printed out, and which are not. Alternatively, the printout
can also be performed via the File menu.
25



4 User Interface
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5 File Menu
5.1 New
This opens a new setup in the working area. The values will be preloaded with
the factory (default) settings.

After calling up this function, the user must first enter the hardware information
for the instrument. The operation corresponds to the menu function Edit 
Hardware identifier and is described in Chapter 6.4.

5.2 Open
Opens an existing setup from a file, and present the contents in the working
area.

5.3 Save
Saves the setup that is shown in the working area to a file. It is only necessary
to enter the file name once. If the file is saved again, no query is made about
the file name.

5.4 Save as
Saves the setup that is shown in the working area to a file. Unlike the Save
function, this always asks for a file name. 

5.5 Close
Removes a complete setup from the working area. If changes have not yet
been saved, this can still be done immediately after calling up the Close
function.

5.6 Delete
Deletes a file from a hard disk or another data storage medium.

5.7 Export as RTF text
The current setup can be saved as an RTF file on the PC. 

5.8 Print
After calling up the function, the selection of what is to be printed is made
next. Printing will start when the selection has been concluded. 

A

The deletion of files is irreversible.
27



5 File Menu
5.9 Print preview
The printed result is displayed on the screen. You can let several pages be
displayed, and alter the size of the pages on the screen.

5.10 Printer setup
Here you can make alterations to the settings for your printer. When the
program starts, the Windows default printer will always be set as the active
printer.

5.11 Default settings
Here you can make alterations to the default settings for the program. Many
alterations will not take effect until the setup program has been restarted.

5.12 Exit
This closes the setup program.
28



6 Edit Menu
6.1 Undo
This undoes the last editing action. In the menu, the Undo item shows which
setting will be undone.

6.2 Restore
The Restore function is only available when the Undo function has been
activated. This function repeats the setting that was previously canceled by
the Undo function.

6.3 Hardware ID ... Process images
Each function has the same effect as double-clicking the corresponding
function in the dialog window.

The following table provides an overview of the parameters that can be altered
by the user:

H
These instructions describe just those parameters that can only be 
configured through the setup program, and not on the instrument.

The description of parameters that can also be configured on the 
instrument can be found in the operating manual B 706585.0.
29



6 Edit Menu
Parameter Configurable through 
the setup program

Configurable on
the instrument

Hardware ID x -

Country settings x -1

1 On the instrument, you can choose between two operating languages

Device data x x2

2 The general device data can be configured on the instrument, but not the
parameter Setup info (device data info).

Screen x x

Analog inputs x x

Binary inputs/outputs x x

Relays x x

Ext. analog inputs x x

Ext. binary inputs x x

Groups x x

Reports x x

Limit monitoring x x

Counters/integrators x x

Serial interface x x

Ethernet e-mail parameters x -

Batches/Plants x x

Date and Time x x

Undocumented 
parameters x x

Customized linearization
x -

Math x -

Logic x -

Batch text x -

Profibus x x

Web server x -

Process images x -

Setup data info
(File info header and
file info text) x -

x = editable,     - = not editable
30



6 Edit Menu
6.4 Hardware ID
This function performs the adaptation of the setup program to the hardware
and extra codes in the instrument. The instrument has three plug-in module
slots, which can have different assignments. The following are available:

• Analog input card with 6 analog inputs

• Combination I/O card with 3 analog inputs and 
8 binary inputs/outputs

• Relay card with 6 relays.

The exact assignment can be determined by comparing the nameplate
(attached to the instrument) and the type designation (see the installation
instructions).

h Choose how the hardware ID will be determined and then click .

Hardware ID is 
defined by the user.

Hardware ID is automatically read out 
from a device.

If the hardware ID is read out 
automatically from a device, then 
the present configuration of the 
parameters can also be read out 
as an option.
31



6 Edit Menu
User-defined 
settings

With user-defined settings, the user determines the hardware ID.

h Select the slot assignments, and click .
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6 Edit Menu
h Select the extra codes that have been fitted, and activate the  
button. The interface “RS232” (= RS232 for barcode reader) is provided as 
standard in the paperless recorder, and is thus not an extra (code). 
Please make sure that you select the interface.

“RS232 interface for barcode 
reader”

Extra code “PROFIBUS-DP interface”

Extra code “Math and logic 
module”
33



6 Edit Menu
h Choose the two languages that will be sent to the instrument as “Language 
1” and “Language 2”, and activate the  button.

A setup file can include more than two languages on the PC side, but only two
will be sent to the instrument. These languages must be placed in the first and
second positions in the language list. The choice that is made here can be
revised at a later date.

v Chapter 6.5 "Country settings"

On the instrument, Parameter  Configuration   Device data  Language
can be used to select the language.

The setting “ ” means that Language 1 and 2
will depend on the installation of the PC program.

Language 1: The language used for installing the PC program. 

Language 2: English (or German if Language 1 is English).

Automatic 
detection

With automatic detection, the hardware is read out from a connected device.
As an option, the current settings for the setup configuration can also be read
out ( ). 
34



6 Edit Menu
6.5 Country settings
After calling up the function, the languages that are available in the setup file
will be shown. If you click on a language with the left mouse button
( ), its properties will appear, and they can be moved to a

different position in the list ( ). The first two languages in
the list will be sent to the device (Language 1 and Language 2). 

Language 
editing

All the available languages can be copied and edited. In this way, the user can
also create new languages. 

               Sorting and moving languages 

Submenu for creating and 
altering languages or 
device texts

Li
st

 o
f t

he
av

ai
la

b
le

la
ng

ua
ge

s

S
ho

w
 o

th
er

 la
ng

ua
ge

s

Characters for the virtual 
device keyboard

H
How to create and edit new and existing languages is described in 
Chapter 11 "Languages".
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6 Edit Menu
6.6 Device data
The device data consist of two sections:

• general device data (also configurable on the instrument) and

• setup info (can only be configured with the setup program).

The setup info is also sent to the paperless recorder. It can be viewed in the
PC evaluation software PCA3000 before being read in or on opening the data,
and can be viewed and expanded in the menu item Edit  Supplementary
description. 

Enter setup info in other languages 
(country settings).

The setup info is entered in the 
window
36



6 Edit Menu
6.7 Screen

Start screen The start screen is displayed when the supply voltage is switched on (Power
On). It must have a size of 320 × 240 pixels, with a maximum of 256 colors.

Watermarks 
(curves)

The watermark is shown as a background to the measurement curves when
using curve presentation for the analog inputs. It can have a maximum size of
200 × 100 pixels, with a maximum of 256 colors.

Watermark 
(History)

The watermark is shown as a background to the measurement curves when
using memory presentation for the analog inputs. It can have a maximum size
of 200 × 100 pixels, with a maximum of 256 colors.

If the tick mark ( ) is set, the  
corresponding screen image will be Select screen 

  Selecting curve colors

H
The color white is used as a transparent color!

H
The color white is used as a transparent color!
37



6 Edit Menu
6.8 Ethernet e-mail parameters
Five e-mails can be sent to up to three users. The precondition is that the
instrument is connected to a network via the Ethernet interface, and the
Ethernet parameters (Extras  Ethernet interface) are correctly configured.

Ethernet
e-mail
parameters

v For other information, flow charts, and error codes, refer to the interface
description B 706585.2.0.

Max. 3 e-mail addressesMax. 5 e-mails

Binary signal that
activates e-mail dispatch

The mail server is 
configured here. 
Alterations should be 
made by a network 
administrator.
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Mail server

In simple company networks it is often sufficient to specify e-mail transmission
via SMTP (Simple Mail Transfer Protocol):
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6.9 Customized linearization
Customer-specific linearizations (max. 40 interpolation points) make it
possible to connect up sensors that are not defined by the linearizations which
are provided ex-factory.

Interpolation points are defined in the Customized linearization menu. They are
used when setting analog channels (Edit  Analog inputs  Linearization 
Customized 1…4).

The following procedure has proven to be advantageous for entering a
customer-specific linearization.

h Select Linearization 1 — 4 (❶).

h Assign a name (❷).

h Choose the type of interpolation (❸).

h Select the sensor type (❸).

h Let the X values be calculated automatically (❺). The values are entered in 
the left-hand column of the interpolation table (❻).

h Enter the Y values in the right-hand column of the interpolation table (❼).

h Use the function (❽) to check the linearization table.

❶

❷

❸

❹

❺

❻ ❼

❽
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6.10 Math
The math and logic module is available as an extra (code). It has to be ordered
with the instrument, or subsequently enabled through the function Tools➔
Enable extra codes.

v Chapter 8.2 "Enable Extra Codes"

The math and logic module are channels that are not available as hardware
but are calculated by the instrument software.

Math channels You can configure the math channels in the “Math” section of the setup
program, or through the menu  Edit ➔  Math. 

In the following example, math channel 3 will be configured:
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6 Edit Menu

 

You must edit the input fields “Variable a”,  “Variable b” or “Time base” if one of the 
standard functions (difference, ratio, humidity, moving average) has been set. 
If you have set the “Formula” function, then the input field “Formula” must be edited. 
Entry can either be direct or via a dialog ( ).

Example: 
Humidity

Function selection

The function is selected here. All other fields can 
subsequently be edited according to the function.

H
With humidity measurement, the channel for dry bulb temperature 
has to be specified as variable A, and the channel for the wet bulb 
temperature as variable B.
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6 Edit Menu
Example: 
Formula

The formula can be entered directly from the PC keys or by calling up the 
  function.

After calling up the function, the following dialog box will appear:

In the left-hand window you can select the required signal, in the right window
the required operator, and then insert them into the formula by activating the

corresponding button ( ). Instead of using  , you can also
make a selection by double clicking.  

H
For functions ending with ( ), you will have to 
add the closing bracket yourself.

Example: 1. SQRT() insert  --> SQRT(
2. AE1 insert --> SQRT(AE1
3. ) insert --> SQRT(AE1)

Click here with the left mouse button to expand or reduce 
the view.
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Operator
overview

Operator
priorities

Operator Explanation Example
+ Addition AE1 + AE2
- Subtraction AE1 - AE2
* Multiplication AE1 * AE2
/ Division AE1 / AE2
( Opening bracket (
) Closing bracket )
SQRT() Root SQRT (AE1)
MIN() Minimum value 

(of several variables)
MIN (AE1, AE2)

MAX() Maximum value 
(of several variables)

MAX (AE1, AE2, AE3)

SIN() Sine
(angle of 360° circle)

SIN (AE1)

COS() Cosine
(angle of 360° circle)

COS (AE1)

TAN() Tangent
(angle of 360° circle)

TAN (AE1)

** x to the power y AE1 ** AE2
EXP() Exponential function EXP (AE1)
ABS() Absolute value ABS (AE1)
INT() Integer portion INT (AE1)
FRC() Decimal portion FRC (AE1)
LOG() Logarithm LOG (AE1)
LN() Natural logarithm LN (AE1)

Priority Math sign / function Comment

High ( ) Brackets

SQRT, MIN, MAX, LOG, LN, SIN,
COS, TAN, ABS, EXP, INT, FRC

Functions

** Exponent (xy)

+, - Sign

*, / Multiplication, division

Low +, - Addition, subtraction
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6.11 Logic
The math and logic module is available as an extra (code). It has to be ordered
with the instrument, or subsequently enabled through the function Tools➔
Enable extra codes.

v Chapter 8.2 "Enable Extra Codes"

The math/logic module is composed of channels that are not available as
hardware but are calculated by the instrument software.

Logic channels Activate the “Logic” section in the setup program, or use the menu Edit ➔

Logic. 

Editing a logic channel is just the same as entering a formula for a math
channel (Chapter 6.10 "Math"); the only difference is in the variables and
operators that are available.

Operator
overview

Operator
priorities

Operator Explanation Example
! NOT ! BE9
& AND BE9 & BE10
| OR BE9 | BE10
^ XOR BE9 ^ BE10
/ Rising edge / BE9
\ Falling edge \ BE9
( Opening bracket (
) Closing bracket )

Priority Operator Comment

High /, \ Edges

( , ) Brackets

NOT, ! Negation

Low

AND, &, 
XOR, ^, 
OR, |

AND link,
exclusive OR link,
OR link
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6.12 Batch text
This function can be used to assign 128 user texts for each of the two device
languages. Texts can be shown in the right column of a current batch protocol.
To do this, the "Content of the right column" for the relevant line must be
configured for "Text list" or "Bin. linked text".

H
A colored border indicated an error in an entry.

v „Errors” on page 90

Language 1

Language 2

128 texts per language

A colored background (colored border)
indicates an error in text entry
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6.13 Profibus
The settings and basic principles of the PROFIBUS-DP interface are described
in the B 706585.2.3 interface description. 

6.14 Web server
The integrated web server gives the user the opportunity to control analog and
binary inputs of a paperless recorder via Ethernet, set batch data on the
device, and track visualizations as they appear on the device with a PC web
browser. Operation is described in the B 706585.0 operating manual.

Depending on the Ethernet configuration (Tools  Ethernet interface), the web
server for the paperless recorder can be called up from the PC with the
Internet Explorer web browser) in one of two ways:

• by entering the IP address (e.g. http://10.10.1.179), or

• (for active DNS device names) by entering the 
name (e.g. http://lsntssc).

List of active 
web server files.

Read in web server files from data medium.

Export web server files to data storage medium.

Remove web server files from the setup file.
The data will not be removed until the dialog is 
ended by the OK button.

Conversion of variable names to addresses 
for web server programming.

Activation of password prompt in PC browser
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Browser
example

H
SVG pictures (SVG = Scalable Vector Graphics) are used within the 
web server. For the correct presentation of SVG, the web browser 
requires a plug-in such as the SVG Viewer from Adobe® (http://
www.adobe.com/svg). 

H
New, specially adapted web server files can be created by the 
manufacturer, if required. Quotation and prices on request.

Navigation area. 
Click with the left mouse button 
to start display.

Window contents. 
Here you can find the 
latest data
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6 Edit Menu
Password-
prompt

The "Security" button is used to start a dialog that serves to protect the use of
the recorder's internal web server (with the web browser) by prompting for a
password.

The user name = Master and password is set to 9200 in the factory. This
makes password prompting active.

Depending on the timeout setting, the prompt appears once when the web
server is called with the web browser (Timeout = 0) or several times (Timeout
<> 0). 

Copy web 
server files 

There are two ways to copy web server files back and forth between setup
files:

h Open setup file with the source files.

h In the Edit menu, start the Web server function.

h Click "Web export", select a folder on the PC, and export the files with 
"OK".

h Open target setup file.

h In the Edit menu, start the Web server function.

h Click "Web import", select the previously selected folder on the PC, and 
import the files with "OK".

h Close the web server dialog with "OK."

h Save the setup file.

H
If password prompting is active, it can be made inactive again by 
deleting the user name and password. If a setting is changed, the 
setup must be transferred to the paperless recorder again.
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6.15 Process images
Process images are a type of visualization for measurement files. The user can
create up to nine process images and save them with the setup program. 

Max. size 315 pixels wide and 187 pixels high.

Process 
imageeditor

Process image 

Selection of a background image

Selection of a background color

Object used Navigation and
editing icons

Preview of the process image
(preview)

Exit process image editor and
accept setting

Leave process image editor but
do not accept setting

Copy current process image to
one or more process images

Object list
50



6 Edit Menu
Navigation and 
editing icons

6.15.1 Create process images

A process image is created as follows:

h Click (left mouse button) to select process image 1 … 9.

h Click to select the object in the object list.

h Double click the selected object or click the icon ( ) to start editing object 
properties.

h Edit properties.

h Select and edit additional objects.

h If desired, you may adjust the background (image) and background color. 
The background color can only be seen if the background image does not 
cover the entire process image area or if the "Transparent" option was 
selected when the image was imported.

h Accept the process image into the Setup file with OK.

h Transfer the setup file to the paperless recorder.

h Select process image visualization on the paperless recorder.

Move object to the object belowMove object to the object below

Move object to the object
above

Copy object in the process image to 
another object

Edit selected object

Move selected object in the process
image (positioning)

Mark selected object in preview for
identification
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6.15.2 Objects

The following objects can be used:

Object Description

Pictogram The status of a binary signal can be represented graphically
by two pictograms (icons or images).

Analog signal Internal and external analog channels. The result of math and
the current time can be shown in numerical form.

Binary signal The status of a binary signal can be represented by a frame
combined with a colored border and text.

Text Fixed text entered in the setup program in one of four sizes.
Unicode is also possible in one size.

Frame Frame for grouping or highlighting objects. 
The frame appears transparent and is automatically in the
background, i.e. a text or analog value,etc. may be inside
this frame and is visible. 

Rectangle Rectangle corresponds to the object frame, but is not
transparent.

Bar graph Internal and external analog channels. The result of math and
the current time can be shown in bar format. Unlike the
analog signal object, scaling must also be specified for the
bar graph object.
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6.15.3 Object properties

Object properties are the same for all objects. The following image describes
the analog signal object.

The object does not appear in the process 
image unless "visible" is set.

X = 0, Y = 0 corresponds to the top
left corner in the process image.

If this option is 
selected, the 
background color is not 

Caution: The background and
foreground colors must be different if
the setting "Transparent" is inactive.

This is the only way to ensure the
object is visible.

Please note the background color of
the process image.
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6.15.4 Preview

All process images can be evaluated in the setup by a preview before they are
transferred to the paperless recorder.

H
Very helpful for editing and moving objects if the preview is moved
in reference to the object list.

h Position the mouse pointer in the header.

h Move the preview while holding down the left mouse button.

Preview of the process image (preview)
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6.15.5 Moving objects

Objects can be positioned to a specific place within the process image by the
object properties (X/Y position). If they need to be moved later, there are three
options available:

• Change X/Y position

• With the "Move" (button ( )

• Directly in the preview holding down the left  mouse button

X/Y position h Select object in the object list.

h Edit object properties (  or double click).

h Change position.

"Move" ( ) h Left-click on the ( ) button.
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h Move the object by clicking the arrow buttons. 
The first time an arrow button is clicked, a preview automatically appears.

h If possible, move the preview to a suitable place so that all windows are 
next to each other.

h To finish, close, the window with the arrow buttons.

Moving in the 
preview

h Click the object in the preview with the left mouse button. 

h Move the object while holding down the left mouse button.
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6.15.6 Background

This function uses an image as a background. The image must be imported
from a data storage medium (e.g. hard drive) into setup. Then it is available in
setup and is no longer tied to the data storage medium.

The background color is only an issue if no background image is being used or
the background image "Transparent" was imported.

Import image into setup

Selected image

Position where the image
is positioned

(top left corner)

if this is selected, X/Y 
position plays no role

Show or hide image
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6.15.7 Import/export image

Images (background images or icons) must be imported into setup before they
can be used.

The import can be performed where images can be used for display
(background, pictogram).

h Click  to start import and selection.

List of images in setup Preview of the
selected image

Import images into setup from data storage medium

Save images as file on data storage medium
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6.16 Setup data info
This function has the same effect as double clicking one of the following
functions in the dialog window.

The File info header and File info text can be used for a description of the
setup file. 

This information is stored only within the setup files, and is not transferred to
the instrument.
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7 Data Transfer Menu
In this chapter, before explaining (from Page 66 on) the function of the data
transfer, it is necessary to provide some general explanation on the topic of
data transfer.

7.1 General
There are two ways of transferring the setup data to or from a recorder:

• transfer via interface, or

• transfer via CompactFlash memory card/USB stick

7.1.1 Transfer via interface

Data transfer is possible via one of the following interfaces:

Setup via RS232 You will need the interface cable (including adapter) in this case. It is available
as an accessory for the recorder. 

PC Paperless recorder

RS232 (with TTL/RS232 converter) Setup interface
(only for recorder type 706580/...)

RS232 (with USB/TTL converter) Setup interface
(only for recorder type 706580/...)

RS232 RS232

RS485 
(plug-in card or converter)

RS485

Ethernet Ethernet

USB USB device interface
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7 Data Transfer Menu
Setup via USB You will need the interface cable (including adapter) in this case. It is available
as an accessory for the recorder.

USB The required setup cable with plugs type A (PC-side) and type B mini (device
side) are enclosed with each setup program.

RS232 v For the pin assignments, please refer to the interface description
B 706585.2.0.

RS485 v For the pin assignments, please refer to the interface description
B 706585.2.0.

Ethernet The paperless recorder or a PC can be connected to the network using
normal, commercially available network cables (with RJ45 connector). If the
recorder and a PC will be connected directly together, please use a crossover
cable.

Starting the 
transfer

Use the toolbar or the Data transfer menu with its functions “„Data Transfer to
Device“and “„Data Transfer from Device“” in order to transfer the setup data.

v Installation Instructions B709720.3.

PC

Paperless recorder

PC

Paperless recorder

Chapter 7.5 "Data Transfer from Device"

Chapter 7.4 "Data Transfer to Device"
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H
This can be configured either on the recorder or through the setup 
program. If, forexample, the Configuration menu is open on the 
instrument, then the instrument cannot be accessed through the 
setup program.
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7.1.2 Transfer via CompactFlash memory card/USB stick

Setup
program

Use the toolbar or the Data transfer menu with its functions „Data Export - Ext.
Mass Storage“ and „Data Import - Ext. Mass Storage“ to transfer the setup
data.

 

Paperless 
recorder

You can use the paperless recorder to write and read setup data to/from the
CompactFlash memory card or USB memory stick.

Import/export errors

If an error occurs on the paperless recorder side during transfer from or to
mass storage , it will be indicated in the Memory manager menu and will
remain until the error has been eliminated or is overwritten by a new error
message.

Notes on the CF 
card

To be able to read or write to/from CompactFlash memory cards from a PC,
you will need a card reader/writer.

When you have installed the card reader/writer, and inserted a CompactFlash
memory card, you will automatically have a new drive under Windows. You
can access this new drive just like a normal hard disk, using Windows
Explorer.

H
Do not use the menu function “File ➔ Save as ”. 

It cannot be used to create a valid CF card for the paperless 
recorder.

Chapter 7.7 "Data Import - Ext. Mass Storage"

Chapter 7.6 "Data Export - Ext. Mass Storage"

A

CompactFlash memory cards must only be removed from the card 
reader/writer when the function “Eject removable medium” or 
“Safe removal of hardware” (functions in the PC operating system) 
has been activated first.

H
Only one configuration file can be saved to the CF card at any 
time, since there is no file name as a variable. 

Measurement data from several instruments can be on the same 
CF card, since they have unambiguous IDs.
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Formatting 
a CF card

To format a CF card using the Windows workplace (e. g. Windows XP):

h Double click the workplace symbol in the “Desktop” area for the PC, using 
the left mouse button.

h Right 
click the drive letter for the CF card.

h Select the Format function.

h Select FAT file system.

h Click the “Start” button.

Information 
about the USB 
memory stick

The same information applies to USB memory sticks as for CF cards, except
that no write/read device is needed.

A

A CompactFlash memory card, (CF card) must be formatted for 
FAT (not FAT32 or NTFS).

If you format a CF card yourself, you must not use fast-formatting 
(quick format). If this is disregarded, a fault free exchange of data 
cannot be ensured.

Select FAT.
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7.2 Make connection

This function establishes a connection ( ) to a device. A connection to a
device is a precondition for transferring a setup to or from a device via an
interface (serial, USB host, or Ethernet).

7.2.1 Device Settings Wizard

If there has never been any previous communication with an instrument, the
“Device Settings Wizard” will automatically be started when the first attempt is
made to access the instrument. It helps you to set up a device list. 

h First select the device version.

h Enter an additional description if appropriate.

h Set one of the option fields if appropriate.

h Activate .

If the option is active ( ), a check 
is made at the end whether the 
chosen device can be accessed 
via the selected interface.

Here you can choose
whether the device should

be defined as the default
device ( ). The system will

automatically access a
default device. Other

devices must be linked
through the device list.
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Logging in to 
the device

Do not 
log in

The default setting of the program is such that the “Master” user is
automatically logged in to a device that is found with the user’s name and
password, and can thus communicate with this device.

Set option ( ) if you do not want to log in. Please note that it is possible that
some functions will not be operable if you are not logged in. The decisive
factor is the current user list and the access rights that are defined in this list.

Saving ID and 
password

If the “Save ID and password” field is active, the log-in is made to the device
with the data that are stored under the “User ID” and “Device password” that
are entered. The default settings are “Master” for the user ID, and “9200” for
the device password.

If the “Save ID and password” field is inactive, then the log-in is made with the
“User ID” and “Device password” that were used to start the setup program.

h Make your selection, and activate the  button.

Save ID and password

Do not log in.
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Interface 
selection

h Select the interface you want to use to access the device.

The next steps depend on the interface or type of connection that has been
selected.

TCP/IP PORT The following parameters must be selected:

Analog 
modem /
ISDN

The following parameters must be selected:

IP address /
HOST name

xxx.xxx.xxx.xxx
(Example: 192.168.0.10)

Enter the IP address for 
your instrument. If you enter 
the name, the IP address can 
be determined by clicking on 
the button “Convert HOST 
name to IP address”.

Port number, 
port name

80 The port used for 
communication.

Communications
protocol

HTTP protocol This has a fixed setting, and 
cannot be altered.

Telephone number Enter the telephone number 
for connecting to the required 
device. 

Connect via Select which 
modem is to be used to make 
the connection. 

Communications
protocol

Modbus protocol This has a fixed setting, and 
cannot be altered.

Device address 1 … 254 Device address for the 
Modbus protocol. 

If modems are used, they must be preconfigured before they can be used. 
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Serial
interface

The following parameters must be selected:

Connected to COM1, COM2 The PC interface to which the 
paperless recorder is 
connected.

Transmission rate 9600, 19200, 38400 The transmission rate must 
match the one that has been 
set in the device.
9600 must be set if “RS232 
setup interface (TTL)” is 
selected as the control signal.

Control signal RS232 If the RS232 interface on the 
device is used. 

RS232 setup interface
(TTL)

If the setup interface on the 
device is used. 

RS422-RTS If the RS422/485 interface on 
the device is used. RS422-DTR

RS485-RTS

RS485-DTR

Expanded Stop bit and 
parity

The parameters under the 
“Expanded” button must also 
match the corresponding 
device parameters.

Standard and obligatory 
settings for the control signal 
“RS232 setup interface 
(TTL)”are:

Stop bit = 1
Parity = none

Communications
protocol

Modbus protocol This has a fixed setting, and 
cannot be altered.

Device address 1 … 254 Device address for the 
Modbus protocol. If the 
“RS232setup interface” is 
used as the control signal, 
then the device address will 
be ignored – it does not have 
to match the address in the 
device.
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USB
interface

The following parameters must/can be selected:

Device List When all settings have been made, the device is entered in the device list.

Communications
protocol

Modbus protocol The 
Modbus protocol
must be set here.

Connected devices Select which device 
should be connected.

If multiple devices are 
connected via USB 
interface, a device can 
be selected here.

Name Activate check
yes/no

If check is active, the 
device will only be 
connected if the device 
name matches. 

F No. Activate check
yes/no

If check is active, the 
device will only be 
connected if the device 
number matches.

CPU Activate check
yes/no

If check is active, the 
device will only be 
connected if the CPU 
number matches.

Path Activate check
yes/no

If check is active, the 
device will only be 
connected if the USB 
path matches.
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7.2.2 Device List

All devices that have been defined are shown in a device list. The interface
parameters are also administered here, and new, additional devices can also
be defined in the device list.

Click  to make a connection to a device. 

When deleting entries, you can use the Ctrl key on the PC keyboard and the
left mouse button to select several devices at the same time and delete them.

A successful connection produces a change in the toolbar.

Make a connection
with the selected device.

Remove device(s) from the

Alter properties
Add a new device

Automatically search the
interfaces for devices.

Use the wizard if the 
function  
“Add new device” or 
“Change properties” 
is launched.

Alter properties

Update presentation of
the device list.

Change device identifier
"online" in

the device.
Import a device list from
a file (e.g. from another

PC).
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Not 
connected

Connected

7.3 Disconnect
This breaks an existing connection between the PC and a device.

7.4 Data Transfer to Device
Transmits a setting setup to a device.

7.5 Data Transfer from Device
Reads in a setting from a device. If there is no connection, the program will
automatically attempt to access the default device.

7.6 Data Export - Ext. Mass Storage
The setting is saved to an ext. mass storage medium (CompactFlash card or
USB memory stick). Data card can be read in to the instrument using the
Memory manager menu.

7.7 Data Import - Ext. Mass Storage
This reads a setting from a mass storage medium (CompactFlash card or USB
memory stick) and displays it in the working area.
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8 Tools Menu
8.1 Enable Program Options
If no valid serial number was entered during the installation of a program, then
it will only run in demo mode. You can use this function to register a program
at a later date and to convert it into a 30-day test or full version.

8.2 Enable Extra Codes
This function is intended for later extensions within the paperless recorder
(e. g. enabling the extra code for “Math and logic module”).
After starting up the function, the function must be used
to read out a code number from the instrument, which is then passed on to the
manufacturer. The manufacturer will then generate a “release number.” The

 function is used to transmit this release number to the
instrument, which will then enable the new device functions.

8.3 Date and time
This function is used to match the date and time for an instrument to the PC
time.

The  and  buttons are used to make a new
setting of date and time for a device. Both functions use the details in the
“New setting” selection as the basis for adjustment.

The  button is used to make date and time settings for a device.
The “Set” function generates a new configuration in the instrument.

H
In order to use a function in the Tools menu, there must be an 
existing connection to an instrument.
If there is no connection, the setup program will try to access the 
default device from the device list. If no default device has been 
defined, then the device list will appear on the screen and the user 
must set up a connection by hand. 

Send the date and time to a device.

Terminates the 

Synchronize a device with the 
PC time. 
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8 Tools Menu
The  function only sets the time. If there is a discrepancy
of more than 30 seconds, then the function will not be carried out. The
“Synchronize” function does not generate a new configuration.

 ensures that the device clock is read out continually

(cyclically). The continual read-out can be ended by activating . The
clock cannot be adjusted while it is is being continually read out.

8.4 Calibration and Testing
This function may only be used by a service engineer of the instrument
manufacturer (or someone acting on the service engineer's instructions.

8.5 Create Screenshot
This function provides an additional option for documenting settings or events.
When you start the function and activate "Create," a  screenshot of the
connected device is created. You can save the screenshot as a bitmap or print
it out directly.

8.6 Ethernet Interface
It is possible to look at and alter the active settings for an instrument if it is
connected to the PC via an Ethernet interface.

8.7 Write Interface Texts
With this function you can: 

• read and write batch texts for the current batch,

• read and write an additional batch text (e.g. a recipe), and

• write event texts.

The function is independent of the present setting in the dialog window (setup
file). The data can be transmitted to a device without causing a new
configuration.

H
If the dialog is terminated by pressing the OK button, then the 
attached device will carry out a restart (reset). If you just want to 
look at the settings, leave the dialog by pressing the cancel button.
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Batch data All the editable fields can be altered and sent to the attached device. If a batch
report is terminated at the instrument, then the instrument (= device) will
continue to use the configuration data. 

Comment A text (e.g. a recipe) up to 400 characters long can be sent to the attached
device and so saved in the course of a batch report. The text can be called up
on the instrument in the visualization of a finished batch report.

If a batch report is terminated at the instrument, the comment will be deleted
from the instrument. Since the data are retained in the dialog window of the
setup program until new data is received, it is possible for edited data to be
sent to an instrument more than once. 

Batch data for each plant

Comment for each plant

Event text for each plant and 
the associated group

Editable field

Read data from device

Send data to device
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External
event text

This function can be used to write a group-specific event text in the event list
of the recorder. Please note that the groups are, in their turn, assigned to the
plants.

8.8 Password Management ...
The password management function can be used to alter the passwords for
the users and their rights, as well as the standard rights (applied when no user
is logged in to the device).

All the characters that are listed can be used for allocating passwords. 

Plant number Group Plant (batch)

1 1 … 9 1

2 1 … 3
4 … 6
7 … 9

1
2
Not assigned

3 1 … 3
4 … 6
7 … 9

1
2
3

Tables 1 — 16
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8 Tools Menu
h Scroll through the individual tables and check whether the character 
selection is adequate for your requirements.

h If not, look for the first available table and then define additional characters.

h When you have finished defining the characters, click .

In the following dialog, the passwords can be allocated for the users, and the
user rights and standard rights can be viewed and altered by clicking

.

8.9 Reset User List ...
This function resets the device user list to the standard settings (user:
“Master”, password: “9200” and user: “User”, password: 0). This function will
only be available if the user who is logged in to the setup program has the
corresponding access rights (e.g. logged in as Specialist).

v Chapter 3 "Log-in and Rights"

8.10 Delete Internal Memory ...
This function deletes the device-internal memory. The function will only be
available if the user who is logged in to the setup program has the
corresponding access rights.

v Chapter 3 "Log-in and Rights"

You should only use this function after the installation of the instrument, or
after setting up a new plant. 

Enter the characters here
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8 Tools Menu
When this function has been performed, the attached device will carry out a
restart (reset).

8.11 Renew Log-in/Alter Password
The function Renew log-in/alter password is used to

• activate the user and password query at the program start, and

• alter the current password.

This function only has an effect on the operation of the setup program, not the
recorder.

Activation of the user and password query at the program start

When the setup program is installed for the first time, there will not yet be a
query of the user name and password when the program starts. You will
automatically be logged in as “Specialist”, with a blank password.

Proceed as follows:

h Start the function “Renew log-in / alter password”.

h Show the options.

h Activate the option “After log-in – alter password” and click .

H
The deletion of the memory contents is irreversible. All the data 
recorded up to this moment will be deleted, and only the active 
configuration will be retained.

Show the options.
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8 Tools Menu
h Enter the password – the “Old password” field remains empty.

When the entry has been concluded, the new password is activated by

clicking . From now on, the user name and the password will be

requested at the program start.

Password alteration

Altering a password is very similar to activating the password prompt. The only
difference is that in this case the “Old password” field must not remain empty.

H
Initially, no start password is assigned to the “Maintenance” user 
either. At program start, log in with the “Maintenance” user name 
and enter a password as described above.
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8 Tools Menu
8.12 Text Library
The text library contains the various operator languages. When a new setup
file is created, the languages will be copied to the setup file if requested. The
first two languages (Language 1 and Language 2) are transferred to the
instrument and can be selected there. 

The operation of the text library is identical to the menu item Edit  Country
setting.

v Chapter 6.5 "Country settings"

v Chapter 11 "Languages"

8.13 Import Text Library
This imports text libraries (own independently created languages) that were
created with Version 187.01.xx setup programs. Imported languages must be
checked by the user for completeness.
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9 Window Menu
9.1 Cascade
If several dialog windows are open at the same time, this function has the
effect that all windows are shown with a small offset to one another. Clicking a
window moves it to the foreground.

9.2 Tile horizontally
If several dialog windows are open at the same time, this function has the
effect that the various windows are shown one above another. You can switch
into each window by clicking it.

9.3 Arrange Icons
All the open windows are minimized – they disappear from the screen, but are
not closed. 

H
The usual Windows options are available for the positioning of
the dialog windows.

Enlarging and minimizing

Reducing and maximizing

Close

Double-clicking with the left mouse 
button produces maximum 
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9 Window Menu
9.4 Teleservice
You can use this function to switch the Teleservice window in or out of display.
Positioning is independent of the position of the dialog window.

You can use Teleservice to request the latest data from a paperless recorder. 

In order to use Teleservice, there must be an existing connection to an
instrument.

v Chapter 7.2 "Make connection"

You can switch Teleservice into or out of display via the Window menu.

Close Teleservice window

Click here to show other tabs 
in the display (if available)

Active tab

Click here to select the register as 
the active tab

Move the Teleservice window.
v „Moving the  toolbar” on page 22
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9 Window Menu
Moving the 
Teleservice
window

The Teleservice window can also be moved. The same options apply as for
moving the toolbar.

v „Moving the  toolbar” on page 22

9.5 Connection Status
You can use this function to switch the connection status window in or out of
display. Positioning is independent of the position of the dialog window.

v „Connection status” on page 22

Position the mouse pointer here. Then, while
holding the left mouse button down, move
the Teleservice window to a different
position.
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10 Info Menu
10.1 Information about Setup
Here you can find out the version number of the setup program. Please have
the version number available if you contact the service hotline.

10.2 Software Documentation
This function calls up the available instrument and software documentation in
PDF format.

10.3 Registered License Numbers
Here you can find out the license number of the setup program. Please have
the license number available if you contact the service hotline.

10.4 Program folder
Here you can obtain information as to which folders (directories) on the hard

disk or in the network are used by the setup program. If you operate the 
button, the contents of the folder will be displayed.
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11 Languages
For languages, a distinction is made between:

• The languages for a setup file 
(Edit  Country settings) and

• The languages in the text library of the setup program
(Tools  Text library). 

It makes no difference where a language is added or changed. It can be
copied back and forth in either direction.

It is not possible to edit a standard language. A standard language can be
recognized by the fact that there are no editable fields in the dialog window. If
a standard language has to be altered, then it will have to be recreated.

11.1 Adding a Language
h Click the language that will be used as a basis in the dialog window, to 

choose it.
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11 Languages
h Select function Language  New language  Create.

A copy of the language will be created, and the corresponding summary data
will be displayed. The presence of white fields instantly shows you that this
language can be edited.

h First of all, give the new language a new name, so that it can be identified 
later.

h The function Language  Edit can now be used to make alterations to the 
new language.
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11 Languages
11.2 Editing Languages

When a new language has been created, the texts are shown as red text on a
white background. This indicates that these texts have not yet been edited (or
translated). 

Use the left mouse button to click in a text field. Then it can be edited. If you
leave the field, the entry for this field is finished. It will be shown as black text
on a white background. This indicates that the text has been edited (or
translated).

Select the language in the left-hand column. 
The language cannot be edited here.

Select the language in the 
right-hand column. Editing 
is only possible in this 
column.

Selection of the 
text category.

Edited text

Unedited text

Active field
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11 Languages
Toolbar The toolbar can be used to alter the status of a text and activate a filter. 

Errors The following errors may occur during text entry, and are indicated by a
colored background: 

Mark the text with a 
bookmark.

Mark the text as 
"edited" (translated).

Mark the text as  
"To be checked"

Mark the text as 
"Unedited."

Filter

The filter is used to
reduce the number of

texts shown in the list.

Background Explanation

Blue Not enough memory available. The total number of 
characters in a text is too long and must be reduced 
(shorten text). 

Yellow The text that was entered is too long – it does not fit into 
the intended window.

Mauve The text that was entered contains characters that the 
instrument cannot display.

Brown Error when editing a wildcard (#). The # symbol is used 
as a wildcard. The instrument software automatically 
generates text to take the place of the wildcard. 
Example: “Device ID #1,100”. 
“Device ID” can be changed, but not “#1,100”.

H
If errors occur, they must be removed. 
A setup file that contains errors must not be transferred to an 
instrument.
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11 Languages
11.3 Device character set
For new languages, you can define the characters that may be used in
entering text for the paperless recorder.

v Chapter 11.1 "Adding a Language" 

h Left-click on a group.

h Then edit the characters that are available in the group.

The characters that are defined here will be visible for text entry to the
paperless recorder. 

Group of characters

Characters in the group
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12 PCA3000 and PCC
12.1 PC Evaluation Software PCA3000

PCA3000 is the professional evaluation software for data analysis of the archived
instrument process data.

PCA3000 is the ideal software for the best-quality graphic and alphanumeric
display of electronically stored measurement data. The software supports
multi-user functionality, so that different users can access the same data.
PCA3000 runs under Windows NT, Windows 2000 and Windows XP.

Data storage The life-cycle  archive  data  structure  enables  on-demand  saving  and
archiving  of  all  process  data,  clearly  and  simply,  in  a  single  file.

Data archive Archive data can be read out and visualized directly from a CD-ROM or DVD (a
transfer to the hard disk is not necessary).

Data export Data export at the HTML level, or as an ASCII text file (for evaluation in Excel).

Communication The data transfer program PCC (Communication Server software) is perfectly
matched to PCA3000, and enables the comfortable read-out of data through
the interface, using RS232/ RS422, Ethernet, a modem, or through the USB
device interface.

H
PCA3000 is described in the operating manual 
B 709701.0 in detail.
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12 PCA3000 and PCC
12.2 PCA Communications Software (PCC)

PCC is the professional archive software: it transfers the data (setup, serial or
Ethernet) from the recorder (or several recorders and controllers) via an
interface, and places it on a PC or network.

H
PCC is described in detail in the operating manual B 709702.0.
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13 Character Set
Entering
special 
characters

Any (special) characters in the setup program that cannot be entered directly
from the keyboard of the PC can be entered with the help of the A key and a
corresponding numeric combination.

Example The special character © has to be entered:

h Position the cursor with the mouse, or by using the cursor keys, at the point 
where the character will be inserted.

h Press the A key and hold it down

h Enter the numeric sequence 0169 on the number block (on the right-hand 
side of the keypad) – the leading zero must be entered as well.

h Release the A key.

The © character is inserted at the cursor position.

Cyrillic 
characters

If “Russian” has been selected as the language for the instrument, then the
characters 0192 … 0255 will be replaced by Cyrillic letters in the instrument.

Example of a 
character code

H
The character set depends on the language of the operating 
system that is used, and may be different from the example. 

Number Char. Number Char. Number Char. Number Char.
032  080 P 0161 ¡ 0209 Ñ
033 ! 081 Q 0162 ¢ 0210 Ò
034 " 082 R 0163 £ 0211 Ó
035 # 083 S 0164 ¤ 0212 Ô
036 $ 084 T 0165 ¥ 0213 Õ
037 % 085 U 0166 ¦ 0214 Ö
038 & 086 V 0167 § 0215 ×
039 ’ 087 W 0168 ¨ 0216 Ø
040 ( 088 X 0169 © 0217 Ù
041 ) 089 Y 0170 ª 0218 Ú
042 * 090 Z 0171 « 0219 Û
043 + 091 [ 0172 ¬ 0220 Ü
044 , 092 \ 0173 - 0221 Ý
045 - 093 ] 0174 ® 0222 Þ
046 . 094 ^ 0175 ¯ 0223 ß
047 / 095 _ 0176 ° 0224 à
048 0 096 ‘ 0177 ± 0225 á
049 1 097 a 0178 ² 0226 â
050 2 098 b 0179 ³ 0227 ã
051 3 099 c 0180 ´ 0228 ä
052 4 0100 d 0181 µ 0229 å
053 5 0101 e 0182 ¶ 0230 æ
054 6 0102 f 0183 · 0231 ç
055 7 0103 g 0184 ¸ 0232 è
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13 Character Set
056 8 0104 h 0185 ¹ 0233 é
057 9 0105 i 0186 º 0234 ê
058 : 0106 j 0187 » 0235 ë
059 ; 0107 k 0188 ¼ 0236 ì
060 < 0108 l 0189 ½ 0237 í
061 = 0109 m 0190 ¾ 0238 î
062 > 0110 n 0191 ¿ 0239 ï
063 ? 0111 o 0192 À 0240 ð
064 @ 0112 p 0193 Á 0241 ñ
065 A 0113 q 0194 Â 0242 ò
066 B 0114 r 0195 Ã 0243 ó
067 C 0115 s 0196 Ä 0244 ô
068 D 0116 t 0197 Å 0245 õ
069 E 0117 u 0198 Æ 0246 ö
070 F 0118 v 0199 Ç 0247 ÷
071 G 0119 w 0200 È 0248 ø
072 H 0120 x 0201 É 0249 ù
073 I 0121 y 0202 Ê 0250 ú
074 J 0122 z 0203 Ë 0251 û
075 K 0123 { 0204 Ì 0252 ü
076 L 0124 | 0205 Í 0253 ý
077 M 0125 } 0206 Î 0254 þ
078 N 0126 ~ 0207 Ï 0255 ˇ
079 O 0128 € 0208 Ð

Number Char. Number Char. Number Char. Number Char.
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14 Index
A
Alter password 78
Arrange symbols 81
Automatic detection 34

B
Batch data 75
Batch text 46
Batch texts 74

C
Cascade 81
Clipboard 25
Close 27
Color settings 37
Comment 75
Commissioning 7
CompactFlash 9, 61, 64
Configuration 23
Connection 66
Connection status 22, 83
Country settings 35, 87
Create screenshot 74
Current setup 23
Curve colors 37
Customized linearization 40

D
Data export to CF card 72
Data import from CF card 72
Data transfer 61
Data transfer from device 72
Data transfer to device 72
Date 73
Date and Time 73
Default Settings 28
Delete 27
Device info 30, 36
Device list 71
Device Settings Wizard 66
Dialog window 23, 81
Directory 85
Disconnect 72
Display printout 74
Documentation, arrangement of 8
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14 Index
E
E-mail 38
Enable extra codes 73
Enable program options 73
Errors 90
Ethernet 61, 74
Event text 74, 76
Exit 28
Extra codes 31, 33, 73

F
FAT 65
Folder 85
Formatting 65
Formula 42
Formula editor 42–43

H
Hardware 31, 34
Hardware and Software Requirements 12
Hardware ID 31
Humidity measurement 42

I
Import/export errors 64
Information about setup 85
Installation 13, 15
Instrument documentation in printed form 8
Instrument documentation in the form of PDF files 8
Interface 61, 68
Interface texts 74

K
Keys 12

L
Languages 30, 34–35, 80, 87
License agreement 14
License number 15, 85
Logging in 67

to the device 67
Logic module 41, 45

Operator priorities 44–45
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14 Index
Log-in 19

M
Mail server 38–39
Make connection 66
Math channels 41
Math module 41, 45

Operator overview 44–45
Operator priorities 44–45

Menu bar 21
Mouse button 24
Moving the Teleservice window 83
Moving the toolbar 22

N
Navigation tree 23
New 27
Note signs 11

O
Open 27

P
Password 19, 67, 76, 79
Password activation 78
Password alteration 79
Password management 76
PCA3000 93
PCC 93–94
Presentation modes 12
Print 25, 27
Print preview 28
Printer Setup 28
Printout 25
Process images 50
PROFIBUS 47
Program folder 15, 85
Program start 15

Q
Quick Start Agent 16
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R
Recipe 74
Registered license numbers 85
Renew log-in 78
Rights 20, 76
RS232 61
RS485 61

S
Save 27
Save as 27
Save ID and password 67
Screen texts 12
Screenshot 74
Serial number 73
Setup info 30, 36
Setup interface 61
Setup software

Start preparations 15
SMTP 39
Software available 14
Software installation 13
Special characters 95
Standard rights 76
Start screen 37
SVG 48
Synchronize 74

T
Teleservice 22, 82
Test Version 15
Text entry 91
Text Library 80
Tiled horizontally 81
Time 73
Toolbar 21, 64, 90
Transfer via CompactFlash memory card 64

U
USB 16, 20, 61–62, 64–65, 70, 72
User name 19
Users 20, 67, 76

V
Version number 85
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W
Warning signs 11
Warranty 7
Watermarks 37
Web server 47
Working area 22
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